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1. INTRODUCTION 

 
Welcome to the User’s Guide for the VistaNET Traffic Manager, a premium 
software component belonging to the VistaNET Network Management System 
(NMS) suite of software tools for the Lentronics Multiplexers family of products, 
which includes JungleMUX, TN1U, TN1Ue and T1MX.  Lentronics Multiplexers 
are designed specifically for the requirements of the utility industry (Power, 
Transportation, Pipelines, Oil & Gas, etc.). 
 
VistaNET provides centralized network management capability for both 
contiguous and non-contiguous networks whose size may range from a few to 
hundreds of Lentronics Multiplexer nodes. The NMS communication with a 
Lentronics Multiplexer network can take place through a direct cable connection, 
a traditional dialup (modem) connection or through a high-speed corporate 
LAN/WAN.  Please refer to the VistaNET Help file for detailed information. 
 
This manual explains how to install and operate VistaNET’s Traffic Management 
software. 
 
 
 
Revision History 
 

Issue No. Issue Date Details of Change 

Issue 1 Mar 2013 Document created. 
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2. PRODUCT OVERVIEW 

 
The management of JungleMUX physical and logical assets is now available 
through a new VistaNET premium software component called the 86456-21 
VistaNET Traffic Manager.  Similar to other VistaNET premium components 
(vSNMP, ATR, VSA), the Traffic Manager is a licensed add-on that enables 
advanced functionality above and beyond standard network management. 
Licensing of the Traffic Manager is performed on a JMUX nodal basis, allowing 
an unlimited number of concurrent users to manage JMUX traffic on equipment 
nodes up to the number of purchased nodal licenses.  A node could be either a 
SONET or T1MX node. 
 
The Traffic Manager is designed to achieve three main objectives 

1. Usage 
Provide users with information to understand their ‘as-built’ JungleMUX 
equipment inventory and provisioned logical circuits (or services).  This 
enables improved equipment management through faster and more 
accurate information access. 
 

2. Availability 
Provide users with equipment and traffic availability information to help 
with network planning initiatives. 

 
3. Performance 

Provide additional troubleshooting tools that assist maintenance and 
support staff assess critical performance parameters and to enable 
trending of such information over extended durations. 

 
Within the sections that follow, a detailed description of these main tasks are 
described, along with additional information on licensing / activation and other 
operational options performed by this VistaNET Traffic Manager 
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Major Components 
 
The VistaNET traffic manager is comprised of two main components, one to 
capture raw traffic data (Traffic Capture) and one to analyze data and produce 
specialized traffic reports (Traffic Analyzer). 
 

The traffic capture function is contained within the Core VistaNET application 
(version 4.04 or higher).  After successful licensing of the Traffic Manager, a 
new traffic manager icon will become visible within VistaNET main tool bar.   
 
The traffic analyzer is a standalone software component that runs 
independent of the Core VistaNET application.  This application can be 
downloaded from www.jmux.com, or obtained through our technical services 
team via VistaNET@ge.com or at 604 421 8610. 

 

http://www.jmux.com/
mailto:VistaNET@ge.com
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3. GETTING STARTED 
 
Pre-requisites 
 
The sequence of nodes within a JungleMUX ring should be correctly assigned 
within VistaNET (Map view) before the traffic capture process is started.  
Typically, nodes follow a sequential format (Node 1 connects to Node 2 connects 
to Node 3 etc.) however this is not always the case.  The traffic capture and 
analyzers program re-uses the node sequence from VistaNET to correctly 
orientate the reported information, and so for that reason, intra-ring node 
sequences should be correct.  Use the VistaNET “View” tab to arrange and 
interconnect the nodes in the correct sequence. 
 
Licensing 
 
VistaNET’s Traffic Manager is a premium VistaNET component that must be 
licensed before this functionality is enabled.  Please refer to the VistaNET user’s 
manual for detailed instructions on how to apply license files within VistaNET. 
 
Specific to this Traffic Manager component, each purchased license of the traffic 
manager is intended to be locked to a specific JungleMUX node (the traffic 
manager is nodal licensed), to be used explicitly for the purpose of managing 
traffic assigned within that node.  Users of this tool who plan on performing traffic 
management of another JungleMUX node must ensure that sufficient purchased 
licenses are applied within VistaNET for each node.  GE does not intend users of 
this tool to re-use a purchased traffic manager license across more than one 
node. 
 
GE defines the ‘use’ of this tool as an operator opening the traffic manager via a 
click on the VistaNET traffic managers icon, then performing a ‘capture’ of asset 
information contained within a JungleMUX ring(s).  Additionally, use of this tool 
includes opening and or analyzing the data stored in the file created by the 
‘capture’ process. 
 
Currently, the VistaNET traffic manager node licenses are applied to the core 
VistaNET software.  By applying a valid license file within VistaNET, the Traffic 
Manager will be enabled and permit users to start the traffic ‘capture’ process 
(Traffic Light icon becomes enabled).  Supplementary node license can be 
purchased and added at any time by contacting GE Digital Energy. 
 
VistaNET will maintain a log of the rings and nodes with which the traffic 
manager has processed. 
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GE defines a node as a JungleMUX SONET node containing a Service Unit 
(SU), IP Service unit (IPSU), or a Cyber Secured Service Unit (CSSU), and a 
JungleMUX T1MX or E1MX node containing a CDAX unit(s) without a Service 
Unit (or IPSU or CSSU). 
 
With the appropriate number of Traffic management node licenses in place, 
users can freely analyze the captured data through GE’s Traffic Analyzer or other 
3rd party software product. 
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4. CAPTURING TRAFFIC 
 
The capture process is really an extended unit discovery that extracts additional 
physical unit attributes and logical circuit routing paths.  Key performance data 
points are additionally saved during the capture process.  VistaNET users initiate 
the traffic capture by clicking on the Traffic Manager Icon (resembling a traffic 
light) located on the main VistaNET toolbar. 
 

 

Figure 1: Initiating a Traffic Capture 
 
 
Users are presented with a pre-
defined list of previously discovered 
JungleMUX rings (T1MX groups will 
be added in the future). Users can 
select a ring(s) to capture the nodes 
assets (hold ‘Ctrl’ key to customize 
selections). 
 
 
Next, define a location to store the 
results of the traffic capture.  A 
standard windows control is presented 
to locate the desired file destination. 
 

Figure 2: Setup a Traffic Capture 
 
Finally, users can start the capture process by pressing the “Start Capture” 
button, at which time VistaNET performs an extended traffic discovery on the 
pre-selected rings.  The discovery status is presented to the user, notifying them 
when the process is finally complete.  Users can optionally cancel the active 
discovery and close the window.   
 
Note:  An output file is only created if the capture process is permitted to run 
through to completion. 
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Upon successful completion of the traffic capture process, an output file (XML) is 
saved in the desired location. The file is additionally time-stamped to allow 
multiple traffic captures of the same inventory to co-exist in the same directory. 
 
Note:  GE will make every attempt to maintain the current structure of this xml 
file, but alternations should be expected over time to incorporate customer 
requested changes. 
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5. ANALYZING TRAFFIC 
 
The previously saved file containing raw JungleMUX traffic data can now be 
analyzed.  GE Digital Energy offers as part of the 86456-21 VistaNET Traffic 
Manager, a standalone JungleMUX traffic analyzer.  Installed on any PC (running 
Windows Operating System) and without any additional product licensing, the 
Traffic Analyzer can accept any number of data files (captured traffic in XML 
format) and perform task-driven traffic analytics. 
 
System Requirements 
 
Minimal PC hardware requirements to install and run the VistaNET analyzer 
include 
 

 Operating System:  Windows XP, Windows 7 

 Memory:  512M 

 Disk:  20G 
 
Obtain the VistaNET Analyzer application by downloading a copy from GE Digital 
Energy’s JMUX website www.jmux.com (login into the My Lentronics customer 
portal and select Software), or request a copy through GE technical services at 
VistaNET@ge.com or at (604) 421 8610 
 
Double click on the downloaded file (TrafficAnalyzer1.msi), and follow the 
installation wizard to complete the setup.  A desktop icon will be added along 
with an entry into the Windows program list. 
 
  

                                            
1 The ‘Major Release version’ . ‘Release date’ is embedded in the file name, 
for example TrafficAnalyzer_500_13058.msi 

http://www.jmux.com/
mailto:VistaNET@ge.com
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Operating the Traffic Analyzer 
 
Select the Traffic Analyzer application from Desktop icon or Windows 
program list.   
 
Select Load Inventory and point the GE traffic analyzer to a saved XML file.  
 
The analyzer will validate the file contents and 
notify the user as to the inventory (Ring numbers) 
contained therein.  It’s possible that a notification 
is returned to the user indicating that an 
older/newer inventory file containing the same 
equipment is already loaded.  Users can then to 
decide which version of the mxl file they would 
like to analyze. 

Figure 3: Load Inventory 
 
 
Additional equipment files can be loaded at any time by visiting the Home tab 
and select Load Inventory again.  Loading new equipment into the analyzer will 
supplement the previously loaded data with new information to analyze. 
 
 
Once the raw inventory data is successfully loaded, the GE Traffic Analyzer is 
now ready to use.  The user 
shall select any of the three 
primary tasks they’d then like to 
perform, including: 
 

 Usage Reports 

 Availability Reports, 

 Performance Reports 
 
 
 

Figure 4: Analyzer Home 
 
Users can safely exit the traffic analyzer by selecting the Home tab, then Exit, or 
simply select the standard windows close icon (red X in the top right corner of the 
application). 
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Traffic Analyzer Exclusions 
 

 The analyzer generates these reports for SONET rings only.   

 Support for SDH networks, Inter-ring ties and support for T1MX or E1MX 
groups are on GE’s development roadmap. 

 
 
Known Product Issues 
 

 TRAC #850:  Ether-100 units are not detected with connected to B86432-
41 OC-3 units.  Any inventory allocated in the OC-3 or Ether-100 units are 
NOT shown up in the ‘Usage” reports 
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6. REPORTS 
 
Reports 

Currently, the GE Traffic Analyzer, offers (or ‘future’ indicates a plan to offer) 
the following sub-task reports, 
 

- Usage 

a. Circuit Tracing 
i. By unit type and bandwidth 
ii. By port type (future) 
iii. By line bandwidth (future) 
iv. By drop Bandwidth (future) 

b. Utilization 
i. By STS-1 
ii. By STS-1 (ATR) 

c. ATR 
i. By bandwidth (STS-1 or VT) 
ii. ATR enabled optics 

 
- Availability 

d. Traffic 
i. By bandwidth (STS-1, VT, DS0) 

e. Physical 
i. By Port type 
ii. By Unit type 
 

- Performance 
iii. Asymmetric Loss 
iv. Network Sync Setup 
v. Optical Miscellaneous Configuration 

 

A brief description of each report type is provided on the following pages 
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Usage:  Circuit Tracing 
Circuit tracing allows users to trace a DS0, VT or STS-1 circuit 
based on a known unit type within a user-defined ring.  This is 
particularly useful to help locate the entry and exit points of a 
circuit, improving user efficiency and accuracy. 
 
 
Usage:  Utilization 
This report presents the overall utilization of STS-1s (Healthy and 
Alternative traffic images) against the overall rings capacity (shown 
as a pie-chart).  When represented in this view, capacity planners 
will gain an immediate appreciation of the network’s capabilities, 
allowing for improved strategic decision making. 
 
 
Usage:  ATR 
Alternative Traffic Routing (or ATR) technology is employed within the OC-3 
(B86432-41), OC-12 (B86417-01) and OC-48 (B86419-01) 
optical aggregate units.  When enabled (ATR is a software 
component for VistaNET that’s available for purchase from 
GE using part # 86456-07), users can pre-program the 
optical units with an alternative traffic image to re-route 
circuits typically to a backup control center during 
catastrophic network disturbances.  This report provides a 
convenient and simplified approach to analyze these critical traffic allocations 
‘offline’, ensuring accuracy if implementation is every needed. 
 
 
Availability:  Traffic 
Knowing unequivocally, which circuits are used and which are 
available to carry future services is extremely important.  The 
impact of accidently ‘stepping on’ another circuit during the 
provisioning process is obviously service-impacting, leading to 
probably outages.  Users of this report can absolutely confirm 
which services (DS0, VT or STS-1) are available within the ring.  
In doing so, each utility will greatly improve the overall system 
reliability, identify economical routing choices (i.e. identifying 
available channels on a previous assigned VT) and improve operational 
efficiencies. 
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Availability:  Physical 
Similar to that of the traffic availability report, users of the physical availability 
report can quickly learn which ports are un-used across 
their JungleMUX nodes.  Imagine how useful that would be 
if you were planning on adding a new service at a pre-
existing site, and knowing that say 3 CBW ports were 
unused at the three sites where your new Ether-1000 unit 
was to be deployed.  Reports identifying available ports can 
be defined by port type or by unit type. 
 
 
Performance:  Asymmetric Loss 
Network operators should ensure that the fiber optic losses in both transmit and 
receive directions approximate each other.  Excessive differences in Tx to Rx 
attenuation can cause communications problems that are often very difficult to 
troubleshoot.  Generally, the loss difference is manageable when kept below 3dB 
(or up to half the power in one direction verses the other).  When asymmetric 
power loss exceeds 3dB, the analyzer will highlight the path so that corrective 
action can be initiated. 
 
Note:  The nodal sequence of nodes within a JungleMUX ring must be correctly 
defined.  VistaNET’s map view plays an integral part.  When performing a 
traditional unit level discovery through VistaNET, a map view is also defined 
containing all discovered nodes.  Users are instructed to arrange and 
interconnect these nodes into a topology that represents the implemented 
hardware.  All reports created within the Traffic Analyzer require VistaNET 
correctly describe the inter-ring topology. 
 
 
Performance:  Network Sync Setup 
Allows users to clearly visualize the orientation of the timing source and 
distribution for the entire ring to ensure these critical fields are correctly 
programmed within the optical aggregate units.  For those with a keen eye, the 
sync status messaging (SSM) quality levels can also be validated around the 
JungleMUX ring, identifying possible synchronization inconsistencies. 
 
Performance:  Optical Misc. Configuration 
The JMUX maintenance program that GE asks each customer to annually 
perform is now conveniently captured within a performance report.  Temperature, 
laser current, code violations in the section and line overhead, etc. are but a few 
of these critical unit-level performance fields.  After a sufficient sample of values 
has been accumulated, maintenance staff can use this data to identify areas of 
interest where preventative maintenance may be targeted. 
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Report Wizard:  Qualifying Data for Traffic Reports 
 
The raw data accumulated during the capture process needs to be refined and 
focused before usable information is output.  Focusing the data from possibly 
tens of thousands of values is accomplished by the traffic analyzer, which starts 
with a series of logical questions to narrow the data set needed for the targeted 
report.  Intuitively, users will select a report type based on what they know (i.e. I 
know what port the equipment is connected to but not the traffic, or I know the 
unit type but not the traffic). 
 
The report wizard is customized for the type of desired report.  Typically, the user 
needs to select the ring #, the node or nodes then some specific report type 
attribute like unit type, port type or bandwidth (traffic) type.  An example is given 
below. 
 
Note:  Only full rings (all nodes) are permitted when running traffic-based 
availability reports.  These report must consider all nodes when returning the 
available intra-ring circuits to ensure each specified circuit is not used elsewhere 
(perhaps outside the search parameters if a sub-set of nodes were permitted). 
 
Example:  JMUX Ring 215 is equipped 
with 4 nodes (1-4).  The originator of this 
report wants to know more about the 
traffic terminated by Ether-10 cards that 
he/she knows exists at nodes 1, 2 and 4.  
The user selected a utilization report type, 
then selects VT by unit type.  The Ether-
10 unit is selected from a larger list of VT-
based units and the report then run. 
 
 
 
 
 
 
 

Figure 5: Unit-based Traffic reports 
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Managing reports 
 
A Generate report button is available after the user has finished qualifying data 
within the Report Wizard.  Once pressed, the report is displayed in the main 
display window of the Traffic analyzer.  Notice in the images below, each report 
generated is presented within a windows tab, allowing users to manage multiple 
reports.  Users can conveniently toggle between each tab to display the specifics 
of each report. 
 
 

 

Figure 6: Managing reports 
 
 
Alternatively, reports can be undocked within analyzer and arranged as desired.  
Undocking windows tabs provide considerable flexibility in viewing multiple 
reports at the same time.  To undock a tab, select the report tab and drag the 
report to the desired screen location.  Microsoft’s Windows positioner (seen 
below in the center of the captured screen) can be used to help snap each report 
to the desired screen location.  A right mouse click on the tab also provides 
management options, including the option to re-dock the tab.  Each report tab 
can be independently closed by clicking the ‘x’ to the right of each tab label. 
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Figure 7: Arranging and Docking/Undocking reports 
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Filters 
 
Users can optionally apply additional report filters to customize the desired level 
of information displayed within each report.  Locate the Filters tab from within the 
Traffic Analyzer and apply filtering as desired.  A Search box is also presented, 
allowing users to select key words (i.e. ‘Right’) within the report (see below) to 
further limit the report results.  Generally, users are attempting to narrow the 
report results to a minimal amount of data that can be easily understood and 
acted upon.  Filters will help users accomplish this. 
 

 

Figure 8: Searching reports 
 
Filters are only available if a valid report is open. 
 
Print and Export 
Each opened report can be printed or exported in a comma delimited format, 
then saved.  Printing and exporting are only available if a valid report is open. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9: Printing and Exporting reports 
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7. KNOWN PRODUCT ISSUES AND LIMITATIONS 

 
Known Traffic Analyzer Product Issues 

 

 TRAC #850:  Ether-100 units are not detected with connected to B86432-
41 OC-3 units.  Any inventory allocated in the OC-3 or Ether-100 units are 
NOT shown up in the ‘Usage” reports 
 
 

Known Traffic Analyzer Limitations 
 

 The analyzer generates these reports for SONET rings only. 

 Currently no support for SDH networks,  

 Currently no support for Inter-ring ties 

 Currently no support for T1MX groups 
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10. ORDERING INFORMATION 
 
 
This section covers the ordering information for VistaNET and its Traffic 
Management premium component. 
 
Please contact the Account Manager for your area regarding ordering the 
VistaNET Traffic Management software. 
 
 
Equipment and Option Code List 
 

 

 
Table 1:  Option Code Table 

 

Equipment Option 
Code 

Description 

B86456 -21 Provides a single Traffic 
Management license that can be 
applied against a single JungleMUX 
SONET node.  One license 
required per SONET node 
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